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Open the Prog

The P-index is Excel based. You need to have Microsoft Excel to use the P-index. This product

ram

has not been tested with open source software.

If you are using Office 2003
You may get this pop-up. Select Enable Macros.

- Disable Macros

Security Warning

"EiiMebraskaP-Index2012, <ls" contains macros.

Enable Macros |

Macros may contain viruses, Ik is usually safe to disable macros, buk iF the
macros are legitimate, vou might lose some Funckionality,

Mare Info

X|

If you do not get this pop-up and the buttons are not working, see the “Changing the Macro

Settings in Excel 2003 section of this manual.

Changing the Macro Settings in Excel 2003
If the program opens, but the buttons do not work:

Go to Tools > Options.
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Changing the Macro
Go to Tools > Options
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Within the Security tab, click on Macro Security.
| LITICOII

I 1
Il Cptions

|: g I Caleulation I Edit. I General | Transition | Cuskam Lisk:
— Color I International I Save I Errar Checking I Speling

File encryption settings for this workbook

Passwaord to open: Advanced... |

File sharing settings For this warkbook

Password ko modify:

I Read-orly recommended

Digital Signatures... |

Privacy opkions

I Remave personal information from file properties on save

Macro security

Adjust the security level For Files that might contain macro viruses and Macro Security... |
specify names of trusted macro developers, =

|

Select Medium and click OK.
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_Emm - ?|x
— Security 21| 2
|: View (Chart I
Trusted Publishers I
— Color curiby
i " Wery High. Only marros installed in frusted locations will be allowed
File enc ta run. All other signed and unsigned macros are disabled.
Passi |
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run. Unsigned macros are automatically disabled.,
File sha —
Passn 1 Medium. You can choose whether or not o run patentially unsafe
macros,
I Re ~ q
Low {not recommended). You are nok pratected From potentially
Digit unsafe macros. Use this setting only if wou have virus scanning
— software installed, or you have checked the safety of all documents
Privacy ou open, —
r Re
Macro s —
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(S
specif L
cncel_|
Encel |

Close the program and reopen it. You will get this pop-up. Select Enable Macros.

Security Warning x|

"E:\MebraskaP-Index2012, xls" contains macros.

Macros may contain viruses, Ik is osually safe to disable macros, bot iF the
macros are legitimate, you might lose some Funckionality,

|55I5I-é'-HQEFE{;-M\EI Enable Macros | More Info |

In the future you should not have to change the macro settings if you maintain the medium
security setting but you will get the “Security Warning” pop-up each time you open the P index.



If you are using Office 2007
You may get a Security Warning bar across the top of the screen. Click Options.

i E Q4 s lebraskaP-Index xls
IGRNL “ R ! NebraskaP-Index2011.xl
e

: Home Insert Page Layout Formulas Data Review View

= Cut : ol | [ [ 1 .

j oGy Arial + |10 |l = = || & | = Wrap Text

" 53 Copy _

b F Format Painter || B L T || B A |[|E = F||E F|| = MegeaCenter - ||| $ - % 9 |

Clipboard F] Font Alignment Number
@ Security Warning Macros have been disabled. Options... «
Al . 5 |

You will get this pop up. Select Enable this content and click OK.

MiMicrosoft Office Security Options 2 x]
@ Security Alert - Macro
R Macro
Macros have been disabled. Macros might contain viruses or other security hazards. Do
. not enable this content unless you trust the source of this file,
‘Warning: It is not possible to determine that this content came from a
trustworthy source. You should leave this content disabled unless the
content provides critical functionality and you trust its source.
More information H
- File Path: E:\MebraskaP-Index2012.xls

& Help protect me from unknown content (recommended)

< Enable this content

Open the Trust Center Cancel

If you do not get the Security Warning bar across the top of the screen, see the “Changing the
Macro Settings in Excel 2007 section of this manual.



Changing the Macro Settings in Excel 2007
If you do not get the Security Warning bar across the top of the screen and the buttons still do not
work, click the Office Button then Excel Options.
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In the Trust Center screen, click Trust Center Settings.
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h, Help keep your documents safe and your computer secure and healthy. ﬁ
Farmulas

B : : n
Proofing Protecting your privacy g

= Save Microsoft cares about your privacy. For more information about how Microsoft Office Excel helps to protect your privacy, =

please see the privacy statements.
| Advanced =

Show the Microsoft Office Excel privacy statement
é Customize Microsoft Office Online privacy statement

Customer Experience Improvement Program
Add-Ins

Trust Center Security & more
Resouiees Learn more about protecting your privacy and security from Microsoft Office Online,

Microsoft Windows Security Center
Microsoft Trustworthy Computing

Microsoft Office Excel Trust Center

The Trust Center contains security and privacy settings. These settings help keep your computer -
secure. We recommend that you do not change these settings. Trust Center Settings...
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In the Macro Settings screen, select “Disable all macros with notification”. Click OK.
o ]

| Trusted Publishers
Macro Settings

Trusted Locations
For macros in documents not in a trusted location:
Add-ins O Disable all macros without notification

@ Disable all macros with notification
ActiveX Settings o

Message Bar

O Disable all macros except digitally signed macros
O Enable all macros (not recommended; potentially dangerous code can runj

Developer Macro Settings
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Privacy Options
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Close the program and reopen.

You should then see the Security Warning bar at the top of the screen.
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You will get this pop up. Select Enable this content and click OK.
21x|

FiMicrosoft Office Security Options

@ Security Alert - Macro

R Macro

Macros have been disabled, Macros might contain viruses or other security hazards, Do
N not enable this content unless you trust the source of this file.

‘Warning: It is not possible to determine that this content came from a

trustworthy source. You should leave this content disabled unless the
t content provides critical functionality and you trust its source. H
-

Mare information

File Path: E:\MebraskaP-Index2012.xls

# Help protect me from unknown content (recommended)
> Enable this content

Qpen the Trust Center

In the future you should not have to change the macro settings. You will get the “Security
Warning” bar at the top each time you open the program.



If you are using Office 2010
You may get a Security Warning bar across the top of the screen. Click Enable Content.

MebraskaP-Index2011 [Read-Only) [Compatibility Mode] - Micro:

Home | Insert  Pagelayout Formulas  Data  Review  View
Agial L1000 - A & P

B I U 4 F iF | £ -

! Security Warning  Macros have been disabled. Enable Content «

If you do not get the Security Warning bar across the top of the screen, see the “Changing the
Macro Settings in Excel 2010” section of this manual.

Changing the Macro Settings in Excel 2010

If you do not get the Security Warning bar across the top of the screen and the buttons still do not

work, click the File Tab then Options.

“ Home Insert Page Layout Formulas Data Review View

= save :
—— Information about NebraskaP-Index2012
ave As
EAMNebraskaP-Index2012.xls
& Open
[ Close

Security Warning

@ Active content might contain viruses and other security hazards. The following
— content has been disabled:

Enable
Recent Content ~ Macros
You should enable content only if you trust the contents of the file.
New Trust Center Settings
i Learn more about Active Content
Print
Save & Send Compatibility Mode
71
\%g Some new features are disabled to prevent problems when working with previous
Help versions of Office. Converting this file will enable these features, but may result in
Convert layout changes.
[z Add-ns -
1 Options
Exit a Permissions
X q
E ) &) One or more sheets in this workbook have been locked to prevent unwanted
changes to the data.
Protect
Workbook - AllSoils Unprotect

loockupSoil Unprotect




In the Trust Center screen, click Trust Center Settings.
2]

General

@ Help keep your documents safe and your com puter secure and healthy.

Protecting your privacy

Microzoft cares about your privacy. For more information about how Microsoft Excel helps to protect your privacy, please see the privacy
statemenits.

Show the Micrasoft Excel privacy statémant

Ement

Advanced Dfficecom priva

ce Improvement Program
Custarnize Ribbor
Security & more
Quick Access Toolbar

Learn maore about protecting your privacy and security from Office.com,
Add-Ins

1 Irustwarthy Computing
Trust Center

Microsoft Excel Trust Center

The Trust Center containg security and privacy settings. These setings help keep your compater secure, We
recommend that you do not change these settings. Trust Conter Setings..

In the Macro Settings screen, select “Disable all macros with notification”.
2]

Trusted Publisher

Macro Settings

Trusts N

' Disable all macros without notification
Trusted Documents & Disable all macros with netification
 Disable all macros ewcept digitally signed macros
s

Enable all macros (not recommended; potentially dangerous code can run)

§ Developer Macro Settings
Macro Settings

[ Trust sccess to the YBA project chject model
Protected View

sage Bar

nal Content

|

In the Message Bar screen, select “Show the Message Bar in all applications when active
content, such as ActiveX controls and macros, has been blocked.” Click OK.




E Trust Center

2|x

Trusted Publishers

Message Bar Settings forall Office Applications

Actived Settings
Bacro Settings
Protected Wiew

[ Message Bar
External Content
File Block Settings

Privacy Optisns

[ Erable Trust Center logging
Fgng

Trusted Locations Showireg th Message Bar

T @ Shenw the Message Bar in all applications when active canitent, such as ActiveX conirols and macras, has been blocked
© [ever show information about blocked content

Add-ing

Cancel ,gl

Click OK again. Close the program and reopen.

You should then see the Security Warning bar at the top of the screen.
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Click Enable Content.
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Calculate Your P-Index

Click on the “Nebraska P-Index” tab at the bottom of your screen to see the worksheet below.
Nebraska Phosphorus Index -IEI_

Please enter the required information in the white and blue boxes. The blue boxes have drop down lists.
The yellow text boxes are locked and used for calculations only.

1. General Information

Run #: 1

Field name : UNIVERSITY JOF
Option name :
Prepared By :
®

Prepared For :

couny- Lincoln

County Number (FIPS Code) : #NIA
Landform Region : l¢_Find Landform Region |

Soil Type :

Soil Map Unit Symbol :

Soil Phosphorus Test Result (ppm) :
Sample Depth : NOTE
Phosphorus Test Type :

2. Irrigation Component

Type of Irrigation :

3. Solid Manure Component

Manure Application Rate (Tons / Acre) :
‘Over how many years : 1.00 NOTE
% dry matter of manure :

4. Runoff Component

W 4 b M| TroubleshootingGuide Help and Instructions | Nebraska P-Index . Report .~ Ephemeral Landform Regions %0 it

Ready | 3 =0 mjaa08,) [

Fill in all white and blue boxes.

Note: Blue boxes contain dropdown lists for your convenience.



General Information Section

Based on the county you entered above, the list of landform regions is developed. If there is
more than one landform region for your county, you can choose your landform region from the
map by clicking the “Find Landform Region” button. You will be directed to this page. Select
the number within your region.

T
Nebraska’s Major Land Resource Areas
60A | |
coery
Cedr
6 kel (171:]
U Prence
6, 65E et o,
Scoss ur corom | GrRaE x‘” |M Sary | (o8 Wardes !
f
Ao neroerns | ogas c: ey ¥ e x| oo .
0 7 =
.ﬁm Kexy f,.mm SawniEis
— [ 107S
Davsos &)H Har
() 7 - 0 A i
0 7 0 Q? pearaey | Adems 7
Dscy rec - mw Tayw B
0
Back to Pindex

Irrigation Component
Select the type of irrigation on your farm.

If you select furrow irrigation (without polyacrylamide or total recapture), this box will appear.
Complete the white boxes. The flow rate is average gallons per minute (gpm) per furrow.

2_Irrigation Component

Type of Irigation : [ =T/ £

FOR FURROW IRRIGATION ONLY

Flow rate (gpm) :
Furrow slope (%) :
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Erosion Component

Ephemeral Erosion

If you do not know the amount of ephemeral erosion on your field, click the “Estimate
Ephemeral Erosion” button. You will get this screen:
Esfimating Ephemeral Erosion

Option # 1
Ephemeral gullies are considered to be gullies that are 3 to 20 inches deep. To estimate soil loss due
to ephemeral erosion for the whole field or management unit, enter the following information for a typical
Total gully length for the field (feet) : [N
Average gully width for the field (feet) :-
Average gully depth for the field (feet) :

ke eatd o M. Use This Estimate

Option # 2

Fill in the white boxes in either of the two options. Click the “Use This Estimate” button within
the option you chose to use the value in the yellow box beside the button

Sheet and Rill Erosion

The P index estimates sheet and rill erosion once all other information for a field area is entered.
You can over-write this estimate with the RUSLE2 value if you prefer.

5. Erosion Component

Conservation Practices : #FNIA
Landform Region (from above) : 0 HNIA
Distance to water bodies (feet) :
‘Grassed Filter Strip Width : #NIA
NOTE Sheet & Rill (e.g. RUSLE2 value):____#vA ||y Recalculate Sheet & Rill Erosion |

Ephemeral Erosion :
Field Area (acres) | |

Tons (total) :| |
\

|

#DIv01 |i E stimate Ephemeral Erosion |

Gully Erosion :
Field Area (acres) :|

Tons (total) :| — |
Irrigation Factor (¢ ion) : 0.00
Manure Factor (from above) : 1.00
Soil Test Factor (erosion) : #NIA

Gross Erosion (average tons /acre fyear) : #FNIA

To use the estimated sheet and rill after overwriting it, click the “Recalculate Sheet & Rill
Erosion” button.
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Phosphorus Index Value
When all boxes have been filled in, the yellow boxes at the bottom of the “Nebraska P-Index”
sheet should contain values.

6. Phosphorus Index Value

Runoff P Value : #N/A Print This Page
Heartland W Erosion P Value : -

Regional Water
e United States Department of Agriculture

Ui bt cahagessos tmvrsives [l \atural Resources Conservation Service P - Index Value : #N/A Add Result to Report
P - Index Text : VY What does my Pindex mean?

To learn more about your P-Index value, click on “What does my P-Index mean?”. You should
then receive one of these pop ups:

T ]

Current practices keep water quality impairment due to agricultural P pollution
low, Manure can be applied at rates sufficient to meet crop N needs,

,
i e -

Delivery of agricultural P may cause seme water quality impairment and
consideration should be given to alternative conservation and P management
practices that do not increase P delivery to surface water. Manure can be applied |
at a nitrogen-based rate if it does not increase the rating of the field or sub-field
above the medium risk category.

High Risk R — ==

- S

Phosphorus loss from the field can cause much water quality impairment.
Remedial action, such as alternative conservation measures or P management
practices, is required, Manure can be applied at a phosphorus removal-based rate
to this field or sub-field as long as recognized phosphorus best management
practices are adopted to reduce the phosphorus index rating to medium during
the next five years.

Ay .—.—!‘ u

Impairment of water quality is extreme. No manure can be applied to this field or
sub-field and remedial action is required to reduce risk.




Near Limit for Risk Class

If you used the built in Sheet and Rill estimator and your P-index value is close to a break point
between two risk classes, for example near the break point between medium and high, you will
get this pop up. The pop up will disappear in a few seconds or you can click ok. We suggest that
you use the RUSLEZ2 rather than the P index estimated value for sheet and rill erosion for these
borderline cases.

T S T o= T T T

=i e fuy flais e ks a
The P-Index walue for this field is near the limit For this P-Indesx risk class. Please use RUSLEZ to obtain a more accurate erosion
estimate,

Clearing the P-Index

You can clear the input form by clicking the “Clear Form” button. However, you can continue to
another field area without clearing the form but by entering the new Run # and field name and
changing only the information where the new field area differs from the previous. If you do not
change the run number, the report page will not work.

Nebraska Phosphorus Index
Please enter the required information in the white and blue boxes. The blue boxes have drop down lists.
The yellow text boxes are locked and used for calculations only.

1. General Information

Clear Form

Run#: 1

Field name : UNIVERSITY JOF
Option name :
Prepared By :
Prepared For : ®

Couny: Lincoln

County Number (FIPS Code) : ENIA
Landform Region : [¢_Find Landform Region |

Soil Type :

Soil Map Unit Symbol :

Soil Phosphorus Test Result (ppm) :
Sample Depth : NOTE'
Phosphorus Test Type :

2. Irrigation Component

Type of Irrigation : [
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Estimate Your Nitrogen Risk

As a convenience to you, in the 2012 version of the Nebraska P-Index, we have added a nitrogen
risk assessment to the program. It takes the data you already entered into the P-Index, as well as
the timing of application, into account when using Table 1 from the NRCS S-590 to calculate
your nitrogen leaching potential. This time-saving addition can be found at the bottom of the
“Nebraska P-Index” sheet.

7. Nitrogen Risk Assessment

Timing of Application :
Soil Type : 0.0
Soil Map Unit Symkol : 0
Soil Texture : #NIA

Nitrate Leaching Potential :| #N/A

Creating a Report for Your Records
Once you have filled in the data for your field, you can move that data to the report sheet. Do this
by clicking the “Add Result to Report” button. You will get a screen like this:

Nebraska Phosphorus Index

Run # 1 2
Prepared by educator

Prepared for example

County Colfax

Field west 1/4

Option base example

Erosion, S&R 11.94

Sediment trap MNone

Field radius 600

Filter width 0-10 ft

Enrichment Tillage
MNo-Till and Conservation Till without
Land use contouring

High Residue Crop/Low residue Crop
Nora variant silty clay loam, 6 to 11 percent

Soil type slopes, eroded (6836)
Soil P 95 ppm (0-8 inches)
Applied P Ibs 100

Surface Application, Mo Incorporation
Irrigation MNone

Rate gpm (furrow only)
Furrow slope%

Manure 10 tons/acre over 1 years

P-Index Value Runoff (1.2) + Erosion (6.4) = 7.6
P-Index Text High
Fall: Low

Spring. Pre-Plant: Low
Nitrate Leaching Potential Sidedress ﬂSgI\t: Low
Run # 4 5
Prepared by
L Help and Instructions Webraska P-Index | Report . Ephemeral Landform Regions Moisture Region 2
Ready | 3 Average: 27.3136361  Count: 33 Numerical Count: 3 Min: 11.9409082 Max: 600  Sum: 7119409082 |[E5 (]

You can do as many as 30 runs or fields in the same program. Click the “Back to P-Index”
button to do another run. Clicking the “Back to P-Index” button will automatically change the
run number.

For your convenience, you can make a change to the data you’ve already entered and look at the
two reports side by side. If you made a mistake in one run and would like to reenter the data for
that run, you can clear just that run. Please see the “Clearing the report” section of this manual.
Unfortunately, at this time, the P-Index cannot repopulate the data that is in the report back into
the Nebraska P-Index sheet. You must reenter the data.

17



Clearing the report
You can clear the entire repoby clicking the “Reset Report” button.

Back to Pdnde; Reset Report JBl. ResetARun |

Nebraska Phosphorus Index
Run # 1 2 3

Prepared by educator
Prepared for example

If you made a mistake or want to change something in just one run, you can clear only that run.
To do so, click on the “Reset A Run” button.

Back to PAndex J | ResetARun %

Nebraska Phosphorus Index
Run # 1 2 3
Prepared by | educator
\Prepared for example

You will get this pop-up box.

T
Partial Report Reset x|
which run would you like reset?

Cancel

Enter the number of the run you would like reset. You can then go back to the P-Index form and
re-enter the data for that run.

Printing in the P-Index Program

The P-Index form may be printed with the entered data to keep for your records. It will print on
two (2) pages. All pages include a footer with the date printed and “The Nebraska Phosphorus
Index 2012 (May 25, 2012)”.

The report is set to print everything visible in that sheet. It will print on five (5) pages. All pages

include a footer with the date printed and “The Nebraska Phosphorus Index 2012 (May 25,
2012)”.

Troubleshooting

The buttons are not working

Check to make sure your macros are enabled. See the “Open the Program” section of this
manual.

The buttons have disappeared or moved
If you are using Office 2007, try closing the program and opening it again.
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| cannot save my data.
When downloading the file from the website, select “Save File” rather than “Open With”.

| pemneiNebraskalelmd ex 0 exis Lj

‘ou have chosen to open

[ NebraskaP-Index2011.xls

whichis a: Microsoft Excel Worksheet
from: http:{fextensionfiles.unl. edu

What should Firefox do with this file?
@
O 5

[] Do this automatically For Files like this fram now on,

i | Microsoft Office Excel (default)

Then click OK.

More information and corrections

If you have problems with the software or would like to suggest corrections to these instructions
or the program, please contact Leslie Johnson at ljohnson13@unl.edu.
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